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Sari

Ada tiga komponen dalam naskah, yaitu teks (tipografi), gambar, persamaan matematika. Gambar dibagi menjadi dua
macam, yaitu raster dan vektor. Komponen-komponen ini sering dianggap sepele oleh sebagian besar penulis, padahal hasil
cetak sangat tergantung kepada komponen ini. Misalnya, pernah kah anda membaca sebuah buku atau artikel yang gam-
barnya tidak jelas, jenis hurufnya tidak enak dibaca, dan pengaturan paragrafnya kacau? KTEX dengan front-end LyX bisa
digunakan untuk me-layout naskah publikasi ilmiah yang konsisten dan padat. IXTEX cukup sulit digunakan untuk kalang-
an pemula yang biasa menggunakan perangkat lunak word processor seperti Word, OpenOffice.org Writer, dll. LyX dengan
tampilan mirip pengolah kata dapat dipelajari dengan mudah tanpa atau dengan sedikit pengetahuan UTEX. Untuk menam-
bahkan gambar atau bagan alir, dapat menggunakan perangkat lunak yang lain, seperti GIMP, Inkscape, OpenOffice.org,
dan Gnuplot. Sedangkan untuk menambahkan bibliografi bisa menggunakan perangkat lunak seperti JabRef, pybliographer,
bibdesk, atau diketik dengan text-editor dengan format bibTgX. Syle pada Ringkasan ini menggunakan paket abstract (lihat

Wilson et al. [2009]).
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1 Pendahuluan

Pada dekade terakhir ini telah dikenal cukup ba-
nyak perangkat lunak bantu untuk menulis naskah,
dari yang sangat sederhana (berbasis text), seper-
ti ChiWriter, WordStar 4-7, Lotus Manuscript; hing-
ga yang canggih (berbasis GUI), seperti WordStar
for Windows, WordPerfect, Lotus WordPro, StarWri-
ter, MicrosoftWord, dll. Semua perangkat lunak ter-
sebut hanya dapat dijalankan pada sistem operasi
DOS/MSDOS dan Microsoft Windows®.

Di lingkungan sistem operasi Linux (dan varian-
nya, seperti Unix, Solaris, dan BSD) juga dikenal
beberapa perangkat lunak OpenSource untuk keper-
luan semacam ini, seperti KWord, AbiWord, Star-
Office Writer, Applixware, OpenOffice.org Writer,
GNU/TgXMACS, IXTEX, LyX, groff, lout, dll. Namun
di antara perangkat lunak ini yang menarik adalah
LyX. LyX merupakan suatu perangkat lunak peng-
olah naskah yang berbasis grafis (GUI), merupakan
front-end dari IXTEX2¢. Sekarang ini, hampir semua
perangkat lunak OpenSource sudah di-port ke dalam
bermacam-macam sistem operasi, seperti Microsoft-
Windows, MacOS X.

2 Publishing

Ada empat komponen dalam naskah, yaitu teks
(tipografi), gambar, tabel, persamaan matematika.
Gambar dibagi menjadi dua macam, yaitu raster dan
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vektor. Komponen-komponen ini sering dianggap
sepele oleh sebagian besar penulis, padahal hasil ce-
tak sangat tergantung kepada komponen ini. Misal-
nya, pernah anda membaca sebuah buku atau arti-
kel yang gambarnya tidak jelas, jenis hurufnya tidak
enak dibaca, dan pengaturan paragrafnya kacau?

Ada cukup banyak referensi tentang bagaimana
membuat publikasi yang bagus, seperti Khazaeli
[2001], Kipplan [2001] dan buku-buku tentang tipo-
grafi, seperti Sthombing [2001], Strizver [2006], Syro-
poulos et al. [2003]. Pada Tabel 1 adalah perangkat lu-
nak berbasis FOSS yang bisa digunakan untuk mem-
buat publikasi naskah ilmiah. Penulis sendiri menye-
lesaikan disertasi tanpa menggunakan perangkat lu-
nak komersial (Microsoft befreien PC = PC bebas Mik-
rosoft, diambil dari headline majalah di Jerman be-
berapa tahun silam...:)). Jadi, gak perlu beli apalagi
membajak, hehe.

3 Apaitu LyX?

LyX (Gambar 1) merupakan suatu sistem prepara-
si naskah yang pada awalnya diciptakan oleh Mat-
thias Ettrich. LyX dapat membuat suatu artikel tek-
nik atau ilmiah yang kompleks dengan matematik,
acuan-silang, bibliografi, indeks, dll. Selain itu, LyX
juga dapat digunakan untuk beberapa bentuk penu-
lisan, seperti memo, surat, disertasi dan tesis, catatan
kuliah, catatan seminar, prosiding konferensi, doku-
mentasi perangkat lunak, buku (tentang PostgreSQL,
penginderaan jauh, kriptologi, cerita fiksi, puisi dan
juga buku-buku untuk anak), artikel yang disitir un-
tuk jurnal, skrip untuk film, proposal bisnis, dll.



Tabel 1: Perangkat lunak berbasis OpenSource yang dapat digunakan untuk mengolah naskah publikasi ilmiah

| Macam analisis | Program (berlisensi GPL)

Keterangan |

ffice

Pengolahan gam- | GIMP dan ImageMagik Mengolah foto dan data raster, dapat untuk mengim-
bar/citra port gambar terformat PDF atau PS.

Grafik Gnuplot, GMT dan SciDavis | Untuk membuat grafik 2 atau 3 dimensi

Paket Office OpenOffice.org dan LibreO- | Untuk mengolah data numerik yang disusun atas ba-

ris dan kolom, dan mengetik naskah teks (word proces-
s07).

Menggambar 2 di-
mensi

Inkscape, Xfig

Alat gambar berbasis vektor, seperti CorelDraw di Mi-
crosoft Windows

Dokumentasi LyX, MikTEX, ProTgXt,

MACTgX, dan TRXMACS

Pengolahan naskah (document processor) berbasis TEX
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Gambar 1: Banner LyX versi 2.x.x

LyX adalah suatu program yang menyediakan su-
atu pendekatan modern pada penulisan naskah de-
ngan komputer. Tidak seperti sebagian besar pengo-
lah kata yang menggunakan paradigma “konsep me-
sin ketik”, LyX menggunakan paradigma ‘markup la-
nguage’ sebagai inti gaya penyuntingan. Hal itu ber-
arti jika kita akan menulis judul subbab, kita tandai
sebagai “Section”, bukan “Bold, 17 pt, rata kiri, dan
5 mm spasi di bawahnya”. Jadi dengan LyX, penu-
lis dapat berkonsentrasi pada isi yang akan ditulis.
Contoh pemakaian LyX untuk menulis karya ilmiah
populer bisa dibaca pada Warmada [2003a,b, 2004];
dan Warmada [2011].

Pada umumnya program pengolah kata selalu
membanggakan dirinya dengan moto WYSIWYG
(What you see is what you get), meskipun tidak tepat
100%, kecuali pada GNU/TEXMACS. LyX di sisi la-
in, memakai moto WYSIWYM (What you see is what
you mean), yang berarti bahwa apa yang ditulis di la-
yar monitor, merupakan naskah yang akan terformat
seperti yang diinginkan. Sehingga apa yang ditulis
pada daerah penyuntingan IyX hasilnya tidak sama
persis dengan apa yang dicetak atau yang ditampilk-
an dengan ghostview atau Acrobat Reader.

Sebagai pengolah naskah, LyX mempunyai bebera-
pa keunggulan, seperti:

e Konsistensi tampilan, dimana tidak terjadi peru-
bahan jenis atau ukuran huruf tanpa disengaja.

Tampilan dikendalikan oleh “style” yang dipilih.

e Penomoran otomatis, seperti pada nomor gam-
bar, tabel, catatankaki, daftar, bab-subbab.

e Referensi silang. Referensi silang antar bagi-
an, misalnya seperti pada penulisan “lihat Gam-
bar 1.1”. LyX dapat menentukan referensi silang
yang tepat, karena semua jenis penomoran dia-
tur oleh LyX.

e Bibliografi dapat dimasukkan secara otomatis
dari database BibTgX. Dengan cara ini tidak akan
ada kesalahan penulisan bibliografi karena kelu-
paan atau kelebihan bibliografi.

e Susunan tata-letak (layout) yang padat.

o Gratis, bersifat Open Source (FOSS): source pro-
gram (dalam bahasa C++ dan Python) bisa di-
modifikasi dan dikompilasi sesuai keinginan.

LyX adalah salah satu front-end IXTEX yang berbasis
GUI, yang dapat dijalankan pada hampir semua pla-
tform sistem operasi. IXIEX sudah cukup lama di-
kenal sebagai alat untuk menata tata letak (layout)
buku atau majalah yang berkaitan dengan ilmu pas-
ti. Dengan munculnya [yX yang dapat dioperasik-
an secara intuitif, hampir semua bidang dapat me-
manfaatkan IATEX sebagai alat untuk menata tampil-
an buku/majalah. Sistem desktop publishing (DTP) di-
gunakan untuk mengedit teks dan gambar yang di-
masukkan pada suatu halaman penuh. Jadi, secara
prinsip hampir semua jenis word- atau document-
processor dapat dijadikan salah satu komponen ma-
sukan dari sistem DTP. Apa keunggulan LyX pada sisi
aplikasi DTP?

IXTEX yang bekerja di balik aplikasi LyX meru-
pakan text-processor yang memiliki banyak keunggul-
an dibandingkan word-processor, di antaranya adalah
konsistensi, referensi-silang dan penempatan gam-
bar/tabel secara otomatis, serta penyusunan pustaka
yang konsisten. Konsistensi tata letak ini disebabkan
karena semua komponen tata letak dikontrol oleh su-
atu makro atau paket IXTEX. Dengan kata lain, sekali
suatu makro didefinisikan maka akan didapatkan ta-
ta letak yang sangat konsisten.

Keistimewaan lainnya dari program ini adalah pe-
ngarsipan berkas dapat dilakukan dengan baik dan
rapi, karena format yang digunakan berupa format



standard, yaitu ASCII atau teks datar (plain text) yang
ditambah beberapa perintah yang dikenal oleh LyX
(LyX-tag). Dengan demikian berkas LyX akan dapat
diakses kapan saja, tidak mengenal batasan waktu.
Hal ini dapat dibandingkan dengan berkas-berkas
yang dihasilkan oleh program pengolah kata lain-
nya yang terformat biner, seperti WordPerfect, Wo-
rdPro, MicrosoftWord, dll. Anda akan mendapatkan
kesulitan bila saat ini anda masih menyimpan berkas-
berkas tersebut dan ingin membukanya kembali. Be-
lum lagi bila anda menuliskan berkas-berkas penting
anda dengan versi lama kemudian anda membuka
atau menuliskan kembali dengan versi terbaru atau
sebaliknya, anda akan mendapatkan tampilan yang
berbeda. Bahkan kadang kala berkas yang telah ditu-
lis banyak data yang hilang.

4 Perbedaan LyX dan pengolah kata

Hal yang paling penting untuk diketahui pada pema-
kaian perangkat lunak LyX adalah merubah paradi-
gma, dari paradigma “konsep mesin ketik” ke para-
digma bahasa “markup”. Berikut ini adalah sesuatu
yang tidak akan pernah ditemukan di LyX:

e Penggaris naskah
e Pemberhentian tab

e Spasi ekstra (misalnya menekan tombol

atau dua kali atau lebih)

Pada pengolah kata, penggaris naskah, fasilitas

ekstra-spasi sangat dibutuhkan karena sega-
la penyusunan kata dilakukan oleh pengguna. Cara
ini sangat berbeda dengan perangkat lunak pengolah
dokumen, dimana semua susunan komponen naskah
diatur oleh perangkat lunak. Meskipun demikian, ki-
ta juga bisa “memaksa” LyX baik untuk ekstra-spasi
ataupun dengan menambahkan makro khusus untuk

Te)

Berikut ini beberapa hal yang ada di LyX tapijarang
digunakan:

Kontrol indentasi
Pemutus halaman (page breaks)

e Spasi baris

e Spasi kosong, baik vertikal ataupun horisontal
e Huruf dan ukuran huruf

e Bentuk huruf (tebal, miring, garis bawah, dll)

Meskipun ini tersedia di LyX, namun tidak harus di-
gunakan jika tidak diperlukan sama sekali. LyX ak-
an mengatur semua hal yang berhubungan dengan
type-setting, tergantung yang style digunakan. Bagi-
an yang berbeda pada naskah akan secara otomatis
diset dengan huruf dan ukuran huruf yang berbeda
oleh LyX. Indentasi paragraf tergantung kepada kon-
tek; jenis paragraf yang berbeda mempunyai inden-
tasi berbeda.

Selain hal di atas, LyX yang didukung oleh IXTEX
dapat mengerjakan hal-hal berikut ini:

e Pemotongan kata (hyphenation) otomatis

Segala macam daftar (isi, gambar, tabel, pustaka,
indeks)

e Rumus-rumus matematika yang kompleks
e Aneka macam tabel
o Referensi silang

5 Migrasi dari MicrosoftWord ke LyX

Di dunia OpenSource, terdapat perangkat lunak untuk
mengonversi file *.doc (versi 2003 ke bawah) yang su-
dah diintegrasi di LyX, yaitu wvCleanLatex. Perang-
kat lunak ini berfungsi untuk mengkonversi *.doc ke
IATEX yang dapat dibaca oleh LyX. Jika perangkat lu-
nak ini tidak tersedia di sistem anda, simpan file *.doc
menjadi *.txt melalui OpenOffice.org Writer. OpenO-
ffice.org menyimpan file *.txt sangat bersih, sehingga
ketika diimport dengan LyX, proses editingnya tidak
memakan waktu. Gambar dan tabel tidak termasuk
dalam teks ini, dan harus diperlakukan berbeda keti-
ka akan diimport dengan LyX.

Gambar dapat disimpan dari OpenOffice.org men-
jadi file terformat gambar (sesuai gambar aslinya),
kecuali bagan alir yang dibuat oleh MicrosoftWord.
Gambar yang terakhir ini harus diperlakukan 'khu-
sus’, misalnya export ke PDF, lalu file PDF dibaca de-
ngan GIMP, dicrop dan disimpan dalam format gam-
bar. Tabel agak spesial daripada gambar, karena LyX
dapat membuat tabel sendiri. Kalau tabel tidak di-
buat khusus, misalnya rata desimal, dll., maka tabel
dapat dibuat dengan menggunakan perangkat lunak
eksternal (misal OpenOffice.org) dan diimport seba-
gai gambar dalam format PS atau PDFE.

6 Menu pada LyX

Seperti telah dijelaskan pada bab sebelumnya, bahwa
LyX bukan suatu perangkat lunak WYSIWYG, namun
merupakan sebuah perangkat lunak WYSIWYM. De-
ngan demikian tampilan di layar monitor akan ber-
beda dengan tampilan yang dicetak. Untuk dapat
menggunakan LyX dengan baik diperlukan penge-
nalan tentang menu-menu pada LyX tersebut.

Secara prinsip, menu LyX mendekati kesamaan de-
ngan menu pada perangkat lunak pengolah kata ber-
basis grafis yang lain. Namun menu LyX tidak se-
kompleks perangkat pengolah kata yang lain, karena
LyX bukan pengolah kata biasa melainkan pengolah
dokumen. Fasilitas penyuntingan kata demi kata ti-
dak tersedia secara lengkap di LyX.

6.1 Menu layar pembuka
6.1.1 Menjalankan LyX.

LyX dapat dijalankan baik melalui konsul atau termi-

nal X dengan memanggil lyx lalu tekan ma-

upun melalui menu pemilihan program pada desk-
top, misalnya Start > Office > Wordprocessor > LyX (ter-
gantung kepada Window manajer yang digunakan).
Setelah pemanggilan ini akan muncul tampilan layar
pembuka LyX seperti pada Gambar 2.

Pada bagian atas Gambar 2 dapat dilihat menu-
menu dari layar pembuka LyX, yang terdiri dari File,
Edit, Insert, Layout, View, Navigate, Documents, dan
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Gambar 2: Tampilan menu pembuka LyX

Help. Namun baik menu pull-down maupun icon ti-
dak semuanya aktif, karena belum ada naskah yang
disunting. Huruf yang bergaris bawah pada menu
merupakan shortcut yang dapat digunakan bersama-

sama tombol , misalnya untuk membuka
menu-menu yang berhubungan dengan berkas. Atau
penggunaan shortcut yang lebih cepat dapat juga di-

lakukan misalnya dengan kombinasi tombol

seperti untuk membuat berkas baru.

Dengan mengklik pull-down menu File atau
akan muncul beberapa pilihan aktif dari semua menu
yang berhubungan dengan perintah File, seperti New,
New from Template, Open, Import, Exit dan Daftar ber-
kas di direktori yang aktif (lihat Gambar 3). Dari keli-
ma menu tersebut yang berbeda hanya satu, yaitu pa-
da menu Import yang mempunyai tanda mata panah
ke kanan, yang berarti masih ada submenu berikut-
nya, yaitu: ASCII text as lines..., ASCII text as paragra-
ph..., IATEX..., LinuxDoc..., Noweb..., dan Word... (Lihat
Gambar 3).

6.1.2 Cara membuka berkas

Jika berkas LyX sudah pernah ada dan akan disun-
ting, maka LyX dapat langsung membuka berkas ter-
sebut tanpa melalui langkah-langkah di atas. Naskah
LyX (misal buku-1lyx.1lyx) dapat dibuka melalui ter-
minal X dengan perintah sebagai berikut:

$ lyx buku-lyx.lyx

Selain dengan cara di atas, membuka berkas lama
LyX dapat juga dilakukan melalui menu File>Open...
sehingga akan muncul kotak dialog seperti tampak
pada Gambar 5.

6.1.3 Mengatur preferensi

Secara default tampilan LyX mungkin tidak sesuai de-
ngan layar yang digunakan, misalnya resolusi layar
tidak cocok dengan besar huruf yang ditampilkan di
layar sehingga huruf menjadi terlalu kecil atau ter-
lalu besar. Untuk mengeset tampilan atau keluaran
LyX secara global dapat dilakukan pada menu Edit>
Preference.... Menu ini terdiri dari beberapa subme-
nu, seperti Look and feel, Language settings, Outputs,
Paths, Converters, dan File formats.

Preferensi Look and feel terdiri atas pengaturan ta-
tap muka (interface), huruf layar, warna, grafik, dan
keyboard (lihat Gambar 6). Hal yang perlu diset pada
pengaturan ini adalah huruf layar, yaitu huruf yang
tampak pada daerah penyuntingan LyX. Huruf ini ti-
dak sama dengan huruf naskah ketika dicetak atau
dipreview. Penentuan huruf ini hanya untuk kenya-
manan ketika menyunting naskah. Pada submenu ini
juga harus ditentukan resolusi layar (Screen DPI) dan
persentase perbesarannya (Zoom %).

Preferensi Language Settings terdiri atas Language
dan Spelichecker. Bahasa secara default ketika LyX
diinstal adalah bahasa, sehingga jika ingin mengetik
dalam bahasa Indonesia misalnya, kolom Default la-
nguage harus diganti dengan Indonesia. Kolom lain
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Gambar 3: Tampilan menu membuat file baru di LyX

Gambar 4: Tampilan menu Import pada LyX.
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Gambar 6: Dialog boks dari menu preferensi layar
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Gambar 7: Dialog boks dari menu preferensi bahasa

secara otomatis diisi oleh LyX (lihat Gambar 7).
6.1.4 Petunjuk penggunaan

Selain buku ini, LyX juga menyediakan petunjuk
penggunaan yang dapat ditampilkan melalui menu
Help (lihat Gambar 8). Pada menu ini dapat dipilih
Introduction, yang berisi pengantar tentang perangkat
lunak LyX. Tutorial berisi uraian secara singkat ba-
gaimana menggunakan perangkat lunak ini. User’s
Guide berisi uraian lengkap bagaimana menggunak-
an LyX. Extended Features berisi uraian mengenai tam-
bahan menggunakan LyX untuk pengguna yang su-
dah mahir memakai LyX. Customization berisi cara-
cara untuk memodifikasi tampilan LyX, baik bahasa
menu maupun keyboard binding. FAQ (Frequently
Asked Questions) berisi beberapa pertanyaan umum
yang sering diajukan oleh pengguna beserta jawa-
bannya. Table of Contents berisi daftar isi dari Help
yang disediakan oleh LyX. KIEX Configuration beri-
si inventarisasi dari konfigurasi IATEX yang terinstal,
seperti paket apasaja yang sudah dikenal oleh LyX.

6.2 Menu layar penyunting

Menu layar penyunting mulai aktif ketika ada nas-
kah yang sedang dibuka oleh LyX. Berbeda dengan
menu pada layar pembuka, yang sebagian besar ba-
ik pulldown-menu maupun ikonnya tidak aktif, me-
nu pada layar penyunting sebagian besar menu dan
ikon aktif. Hanya ada beberapa menu dan ikon yang
tidak aktif, seperti potong (cut), salin (copy) dan tum-
puk (paste). Layar penyunting dapat dibagi menjadi
lima bagian:

1. Pulldown-menu terletak di bagian paling atas

2. Ikon terletak di bawah pulldown-menu

3. Ruang kerja (workspace) merupakan daerah tem-
pat mengetikkan apa saja dari naskah yang akan
dibuat

4. Ruang untuk memasukkan perintah pendek
pada perintah misalnya accent-grave

a untuk menuliskan huruf “a”.

5. Komentar kerja LyX termasuk deskripsi font pa-
da lokasi pointer.

6.2.1 Tulis, simpan, tampilkan dan cetak

Empat hal yang secara berulang-ulang akan di-
gunakan pada saat menyunting naskah dengan
LyX. Untuk mencoba menggunakan perangkat lu-
nak ini, cobalah membuat suatu berkas, misal-
nya coba.lyx dengan perintah File>New... maka
akan muncul layar kosong dengan nama header
LyX:.../IyXdocuments/newfilel.lyx. Hal ini berarti
berkas baru LyX sudah siap untuk diisi.

Sebagai contoh, ketikanlah isi tulisan berikut ini
pada naskah kosong tersebut lalu simpanlah dengan

perintah Filer>Save atau atau File>Save As...

atau | Ctrl-S | dengan nama coba. LyX secara otomatis
akan menambahkan ekstensi .1lyx dari nama terse-

but.

Sekarang saya sudah bisa mengetikkan ber-
kas.lyx dengan bantuan dari buku ini. Meli-
hat tampilannya yang sederhana dengan sedikit
ikon, saya menjadi ragu untuk mencobanya. Na-
mun berkat “komporan” teman-teman yang su-
dah lebih dulu memakai LyX akhirnya saya men-
jadi sulit melupakan LyX. LyX begitu memukau
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Gambar 8: Beberapa pilihan alat-alat bantu pada menu Help

saya akan hasil keluarannya baik dalam format
elektronik (PostScript dan PDF) maupun hasil
cetaknya.

Berikan juga tambahan beberapa teks seperti misal-
nya “Belajar LyX lima menit....” lalu klik tanda pa-
nah ke bawah pada kolom “Standard” (kotak paling
kiri kumpulan ikon) dan pilih “Title”. Jangan lu-
pa mengetikkan nama anda sebagai penulis (Author)
dan pilih “Author” pada kolom “Standard”. Arti-
kel yang anda tulis sudah cukup lengkap, lalu klik
View > Postscript untuk melihat tampilannya dengan
GSView/gv, atau View > PDF untuk melihat tampilan-
nya dengan Acrobat Reader.

6.2.2 Spasi, TAB dan Enter

Seperti telah diuraikan pada subbab 4 bahwa LyX ti-
dak mengenal Spasi dan Enter lebih serta TAB. Mes-
kipun kita menekan tombol Spasi berulang-ulang,
spasi akan tetap satu karakter. Ini merupakan stan-
dar penulisan tulisan ilmiah yang padat. Begitu juga
tombol Enter, LyX tidak mengenal spasi antar para-
graf lebih dari satu Enter.

Namun demikian, LyX memberikan fasilitas untuk
menambah spasi horisontal maupun vertikal suatu
naskah yang akan kita sebut sebagai spasi tidak nor-
mal. Spasi horisontal tidak normal dapat dilakukan

dengan menekan tombol dan bersama-

sama. Penambahan spasi vertikal tidak normal da-
pat dilakukan dengan dua cara, yaitu dengan per-

intah + yang akan muncul seperti pa-

da Gambar 9 atau dengan menambahkan spasi an-
tar paragraf melalui perintah Layout> Paragraph...>
Spacing yang akan muncul seperti pada Gambar 10.

wwwes — menambah spasi horisontal
o

L1

Perintah di atas untuk menambah spasi vertikal dengan

kombinasi tombol |[Ctri+Enter| atau dengan menambahkan

jarak antar paragraf, seperti berikut ini:

Vertical Space (1.5cm, protected)

Jarak antara paragraf di atas dan paragraf ini. Atau bisa juga
dengan menambahkan perintah dalam ERT \wspace*{1.5cm}.

Gambar 9: Cara menambahkan spasi tidak normal
pada naska LyX

6.2.3 Menyunting naskah

Menyunting naskah tidak jauh berbeda dengan pe-
ngolah kata yang lain. Tombol-tombol standard yang
biasanya digunakan untuk menyunting naskah da-

pat digunakan untuk LyX, seperti untuk me-
nyalin teks dan untuk menempelkan salinan

kembali. Begitu juga dengan perintah dan
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Gambar 10: Tampilan layout paragraf untuk menam-
bahkan spasi antar paragraf

yang masing-masing untuk menghapus teks
dan membatalkan perintah.

Selain perintah-perintah di atas, perintah standard
penyuntingan pengolah kata juga bisa digunakan, se-
perti perintah-perintah berikut ini:

o [Home] atau [ End] untuk meletakkan pointer pa-
da awal atau akhir dari baris kalimat yang ditun-
juk oleh pointer.

o [CtrI-Home] atau[CtrI-End] untuk meletakkan po-
inter pada awal atau akhir naskah.

. [Ctrl-<—] atau [Ctrl-—)] untuk memindahkan po-
inter pada huruf awal atau akhir dari suatu kata
terdekat.

. [CtrI-T] atau (Ctrl-” untuk memindahkan pointer
antar alinea.

e | Ctrl-Delete | untuk menghapus kata yang terle-

tak di belakang pointer.

o untuk menghapus kata yang
terletak di depan pointer.

Selain perintah-perintah di atas, juga tersedia ikon-
ikon sebagai fasilitas penyuntingan pada perangkat
lunak LyX yang dapat dibagi menjadi tujuh bagian:

Standard v .
o merupakan ikon untuk me-

milih lingkungan paragraf dari naskah yang se-
dang diedit.

- 1 IH f
£ E & merupakan ikon input-output

yang terdiri atas membuka, menyimpan dan
mencetak naskah.

% i
=BG merupakan ikon-ikon un-
tuk mengedit naskah.  Berturut-turut dari
kiri ke kanan adalah undo/redo, memo-
tong/menghapus, menyalin, menumpuk teks,
pencarian dan penggantian, navigasi balik.

A & & ikon ini digunakan untuk menset
huruf, dari kiri ke kanan berturut-turut adalah
huruf miring (emph) atau , NOUN atau
SMALLCAPS, dan font yang definisikan penggu-
na. Membuat huruf tercetak tebal dan bergaris

bawah dapat dilakukan dengan perintah

dan .

o 2 = ikon ini berguna untuk menyisipk-
an gambar dan tabel non-float pada naskah.

Voo )
B merupakan ikon untuk menyisipk-
an perintah ERT atau TEX style dan makro persa-
maan matematika.

7 Menggunakan style

Berbeda dengan pengolah kata yang biasanya lang-
sung menulis tanpa memikirkan bentuk tulisan yang
bagaimana yang akan dibuat, pada pengolah doku-
men langkah awal adalah menentukan jenis naskah
yang akan dibuat. Penentuan jenis naskah (document
class) akan mengarahkan kepada lingkungan para-
graf yang akan muncul. Sebagai contoh pada je-
nis naskah buku (Book) akan muncul lingkungan bab
(Chapter), sedangkan pada jenis naskah article (arti-
kel) lingkungan ini tidak akan muncul. Penentuan
jenis naskah ini merupakan pemformatan dasar dari
program LyX.

Pemformatan ini dapat dilakukan dengan meng-
klik perintah Layout>Document... sehingga akan
munchl tampilan kotak dialog seperti pada Gambar
11. Pada kotak jendela tersebut terdiri atas bebera-
pa bagian, seperti Layout, Paper, Margins, Language,
Bullets, Numbering, Bibliography, Packages, dan Pre-
amble.

LyX dirancang sedemikian rupa agar waktu untuk
mengatur atau memformat tata-letak naskah dapat
dilakukan seminimal mungkin. Sehingga pekerjaan
hanya difokuskan pada pengetikan isi naskah. Oleh
karena itu dibutuhkan beberapa hal dalam kegiatan
mengatur tata-letak komponen naskah:

o Kelas naskah
e Lingkungan paragraf
e Jenis huruf

Sebuah Klas naskah menetapkan format lain yang
tersedia, tetapi untuk sebagian besar anda tidak
membutuhkan keistimewaan tersebut. Standard je-
nis Klas naskah adalah Article yang sangat sesuai de-
ngan sebagian besar jenis naskah yang anda tulis, te-
tapi anda dapat juga mencoba bereksperimen dengan
jenis Klas naskah lainnya.

Untuk mengubah setiap jenis Klas naskah dapat
anda lakukan dengan mengklik menu Document>
Settings...> Document Class yang akan terlihat seperti
pada Gambar 11. Setelah itu pilih jenis Klas yang dii-
nginkan sesuai dengan keperluan. Hingga pada pro-
gram LyX versi 2.0.1 secara lengkap jenis-jenis Klas
naskah yang terdapat adalah sebagai berikut:

Curriculum Vitae

DocBook article (SGML)
DocBook book (SGML)
DocBook chapter (SGML)
DocBook section (SGML)
SGML (Linuxdoc article)
SGML (Linuxdoc manpage)
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Gambar 11: Kotak jendela tata-letak naskah

Article (AMS)

Article (AMS, sequential numbering)
Article (AMS, unnumbered)
Article (Hebrew)

Article (REVTEX 4)
Article (REVTEX)

Article (Springer- eJour2)
Article (Koma-Script)
Book

Book (AMS)

Book (Koma-Script)
Broadway

Hollywood

Letter

Letter (Hebrew)

Letter (g-brief)

Letter (g-brief, german)
Letter (german)

Letter (italian)

Letter (koma-script)
Report

Report (koma-script)
Seminar

Slide (default)

8 Gambar dan tabel

8.1 Format gambar

Arikel atau buku tidak akan lengkap tanpa ada gam-
bar baik berupa grafik maupun gambar raster di da-
lamnya. Dalam grafik dikenal ada dua macam for-
mat gambar, yaitu gambar vektor dan gambar raster.
Gambar vektor sangat mudah disisipkan pada IXTEX
atau LyX, karena hampir semua program penghasil
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grafik vektor menghasilkan format grafik standard
postscript atau EPS (Encapsulated PostScript). Berbeda
dengan gambar vektor, gambar raster sangat mem-
punyai jenis yang sangat beragam, misalnya bmp
(Windows bitmap), tiff, jpeg, gif, png, targa, dll. Apa-
kah LyX bisa mengimport jenis gambar ini?

Sebelum menjawab pertanyaan ini, kita bisa lihat
terlebih dahulu jenis format data apa yang akan di-
kirim ke devais keluaran selain devais bebas (dvi, de-
vice independence), yaitu printer atau layar. Ada dua
macam format keluaran yang biasa dipakai untuk hal
ini, yaitu postscript dan pdf (portable data format). Da-
lam penyisipan gambar raster pada berkas IATEX ke-
dua tipe format keluaran ini memerlukan perlakuan
masing-masing, karena kedua format ini bukan stan-
dard keluaran I4TEX (keluaran standard I£TEX adalah
dvi). Untuk menghasilkan berkas postscript IXTEX
membutuhkan program bantu lain seperti dvips, se-
dangkan untuk menghasilkan berkas pdf program ini
membutuhkan program bantu ps2pdf atau pdflatex,
tex2pdf, pdftex.

Pada keluaran postscript atau pdf melalui program
ps2pdf, gambar raster yang bisa disisipkan langsung
adalah berformat eps. Namun bukan berarti format
selain ini tidak bisa disisipkan pada berkas LyX. Pada
prinsipnya berkas gambar jenis apa saja dapat disi-
sipkan dalam berkas LyX, selama program konversi
berkas tersebut ke dalam berkas eps tersedia dan da-
pat diakses oleh program TgX.

Berbeda dengan keluaran postscript, pada keluar-
an pdf melalui program pdftex, pdflatex, tex2pdf
belum dikenal grafik berformat eps. Format gam-
bar yang dikenal oleh program pdftex misalnya pdf,
png, dan jpeg. Selain format ini harus dikonversi ke
salah satu dari tiga jenis format ini. Dalam lingkung-
an Linux tidak terlalu sulit. Tersedia banyak program



untuk mengkonversi ke salah satu berkas ini, misal-
nya convert (ImageMagick), epstopdf, pnmtopng.

Dalam pembuatan naskah, gambar yang paling
penting adalah resolusinya. Resolusi yang terlalu be-
sar menyebabkan berkas menjadi gemuk dan berat ji-
ka diakses dengan internet, sedangkan resolusi yang
kecil menyebabkan gambar menjadi kabur atau bu-
ram. Berapakah resolusi yang tepat? Tergantung for-
mat gambarnya, apakah raster atau “rasterized” vek-
tor (sama-sama raster). Resolusi yang paling aman
adalah 450 dpi pada semua gambar raster. Tidak ada
resolusi untuk gambar terformat vektor.

8.2 Membuat tabel

Tabel merupakan salah satu cara untuk menampilk-
an ringkasan data dari suatu teks. Satu buah tabel
dapat mewakili ribuan kata-kata. Tabel dapat terdiri
dari teks atau angka-angka. Tabel teks biasanya digu-
nakan untuk menampilkan deskripsi suatu hal seca-
ra tabelaris. Ada beberapa cara yang dapat digunak-
an untuk menampilkan tabel teks secara baik dengan
menggunakan LyX.

8.2.1 Tabel pendek/sederhana

Yang dimaksud dengan tabel pendek adalah tabel
yang panjangnya tidak melebihi margin kertas (diu-
kur dari caption sampai catatankaki tabel, lihat con-
toh Tabel 2). Tabel jenis ini dapat dibuat mengam-
bang dalam teks atau statis. Mengambang artinya
posisi akhir tabel akan disesuaikan tempatnya oleh
ETEX.  Untuk memudahkan layout sebaiknya pa-
kai tabel jenis mengambang (floating table). Perintah
untuk membuat tabel mengambang adalah Insert>
Float> Table Float. Dari perintah ini akan muncul jen-
dela float seperti berikut ini:

Isilah judul tabel (caption) terlebih dahulu lalu tek-
an Enter. Untuk membuat tabel dapat dilakukan de-
ngan prosedur:

e Letakkan pointer persis di bawah judul tabel (di
dalam jendela float)

e Lakukan perintah Insertr> Tabel

e Isi berapa jumlah baris dan kolom yang akan di-
buat, misalnya 4 x5 (lihat jendela berikut)

e Isikan tiap sel tabel dengan data yang diingink-
an.

8.2.2 Mengatur tampilan tabel

Secara default, tabel yang didefinisikan dengan LyX
pada menu insert-tabel akan meletakkan komponen
penyusun tabel pada posisi rata tengah. Untuk meru-
bah layout ini dapat dilakukan dengan perintah beri-
kut:

e Letakkan pointer pada salah satu sel tabel, lalu
klik Layout> Table

e Klik bagian Column/Row, dan pilihlah apakah
komponen tabel akan dibuat rata kiri, tengah
atau kanan.

e Garis pembatas antar sel juga dapat didefinisik-
an di bagian ini.
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Sering kali antara judul kolom dan bagian lain dari
tabel mempunya layout yang berbeda, misalnya pa-
da judul kolom didefinisikan rata tengah, sedangkan
bagian lain rata kiri (seperti contoh di atas). Tampilan
ini dapat dilakukan dengan mendefinisikan sel seba-
gai multicol.

9 Persamaan matematika

9.1 Satuan yang tersedia

Satuan atau besaran pada naskah LyX dapat dipilih
sesuai keinginan dan jumlahnya ada sekitar 17 satu-
an, misalnya dapat dilihat pada Tabel 3. Tidak disa-
rankan menggunakan satuan standard pada penga-
turan naskah, seperti mm, cm, dan in. Gunakan sa-
tuan % atau lebar atau tinggi karakter (seperti lebar
huruf M (em), atau tinggi huruf “x” (ex)), sehingga
ketika huruf pada naskah dibesarkan atau dikecilk-
an secara serentak, proporsi jarak akan sesuai dengan
besaran huruf, tidak konstan kalau menggunakan sa-
tuan standard. Jarak antar kolom ini menggunakan
besaran em, i.e., 1.5em. Di dunia pengolah kata tidak
dikenal satuan ini...;).

Tabel 3: Satuan yang tersedia

| Satuan | Nama / Deskripsi
mm Millimeter
cm Centimeter
in Inch (1in = 2,54 cm)
pt Point (72.27 pt = 1in)
pc Pica (1 pc=12pt)
sp scaled point (65536 sp = 1 pt)
bp big point (72bp = 1in)
dd Didot (1 dd ~ 0.376 mm)
cc Cicero (1cc=12dd)
ex Height of letter “x” in the current font
em width of letter “M” in the current font
mu math unit (1 mu = 1/18 em)
% Text Width %
Y% Column Width %

9.2 Menulis persamaan

Menulis persamaan di LyX jauh lebih mudah diban-
dingkan dengan menggunakan Equation Editor di
MicrosoftWord. Selain dengan menu box yang ter-
sedia di jendela LyX, persamaan dapat juga dibuat
dengan perintah IXTEX, misalnya untuk menulis akar
kuadrat bisa langsung diketik \ sqrt pada modus ma-
tematika. Penggunaan perintah short-key bisa juga

dilakukan, seperti tombol untuk menampilk-
an modus matematika. Tombol untuk mem-

buat superscript dan | Shift-_| untuk subscript.
Macam-macam ukuran kurung besar (bracket), lihat
Persamaan 1. Persamaan di atasnya tidak menggu-

nakan label, sehingga tidak bisa diacu dalam teks.

1 tn
Uijt =In 0

1



Tabel 2: Contoh tabel sederhana di LyX

Nama |

Materi yang disajikan |

Tip dan trik menginstal dan menggunakan LyX

Dr. I Made Wiryana, MSc.

Tip dan trik sistem sekuritas dengan Linux

Dr. I Wayan Warmada

Tip dan trik mengolah grafik di Linux

| No. |
1. Dr. Abe Susanto, M.Sc.
2
3
4

dan lain-lain

05

<exp < [{ In(3x)} sin(x)r>> (1)

10 Bibliografi

Penanganan bibliografi dapat dilakukan dengan da-
tabase, yang disebut BibTgX. Semua bibliografi di-
masukkan ke dalam satu file yang terformat bibtex
(*.bib). Untuk memasukkan database ini bisa dila-
kukan dengan beberapa perangkat lunak OpenSour-
ce, seperti JabRef (semua platform OS), pybliogra-
pher (Linux), bibdesk (MacOS X), atau manual de-
ngan text-editor. Contoh format bibTEX sebagai beri-
kut (jika tidak punya perangkat lunak di atas):

@Book{kip01,
Author = {Kipplan, H.},
Title = {\textit{Handbook of {P}rint

{M}edia: {T}echnologies and
{P}roduction {M}ethods}},
Publisher = {Springer-Verlag},

Address = {Berlinm},
Note = {1207p.},
year = 2001

}

@Article{war03b,
Author = {Warmada, I W.},
Title = {\IyX{} sebagai aplikasi

desktop publisher},

Journal = {Infolinux},
Volume = {09/2003},
Pages = {76-78},
year = 2003

}

Rangkuman
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an terdiri
atas empat kom- ponen utama, ya-
itu tipografi, gambar, tabel dan persamaan
matematika. Salah satu dari komponen ini tidak
dilakukan dengan serius akan menghasilkan layo-
ut yang jelek, misalnya gambar buram, garis pada
gambar vektor patah-patah (apalagi jika diper-
besar), persamaan tidak enak dibaca. LyX dapat
digunakan untuk bermacam-macam keperlu-
an penulisan karya tulis ilmiah mulai dari
artikel, laporan penelitian, skripsi, the-
sis master, dan disertasi. LyX juga
dapat digunakan untuk mem-
buat tulisan romantis
dalam bentuk se-
perti ini.

@

penerbit-

%

tu-

lisan

ini  dibuat
dengan perang-
kat lunak LyX dan
IATEX 2¢. Gambar di-grab
dan diedit dengan perang-
kat lunak GIMP menggunakan
resolusi layar, 96dpi. Bibliografi
menggunakan bibTEX dan pybliographer.
Style bibliografi menggunakan style arti-
kel Elsevier dengan model Harvard. Paket
tambahan yang digunakan pada artikel
ini terdiri atas: abstract, cuted,
flushend, titlesec, mathpazo,
fancybox, shapepar, color.
Semua paket ini meru-
pakan paket stan-
dard yang su-
dah tersedia

pada

ATEX.
<
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